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CAUTION
Indicates that incorrect operation presents possibility of injury to
the user or damage to the instrument.

NOTE Indicates advisory items related to performance or correct
operation of the instrument.

Introduction

Notes on Use

Thank you for purchasing the HIOKI "Model 9334 LOGGER
COMMUNICATOR". To obtain maximum performance from the disc, please
read this manual first, and keep it handy for future reference.

Trademarks
Pentium is a registered trademark of Intel Corporation.
Windows and Internet Explorer is a registered trademark of Microsoft
Corporation.

Follow these precautions to ensure safe operation and to obtain the full
benefits of the various functions.

Always hold the disc by the edges, so as not to make fingerprints on the
label side or scratch the printing.
Never touch the recorded side of the disc. Do not place the disc directly
on anything hard.
Do not wet the disc with volatile alcohol or water, as there is a possibility
of the label printing disappearing.
To write on the disc label surface, use a spirit-based felt pen. Do not use a
ball-point pen or hard-tipped pen, because there is a danger of scratching
the surface and corrupting the data. Do not use adhesive labels.
Do not expose the disc directly to the sun's rays, or keep it in conditions
of high temperature or humidity, as there is a danger of warping, with
consequent loss of data.
To remove dirt, dust, or fingerprints from the disc, wipe with a dry cloth,
or use a CD cleaner. Always wipe radially from the inside to the outside,
and do no wipe with circular movements. Never use abrasives or solvent
cleaners.
In the interests of ongoing product developments, there may be minor
discrepancies between screen displays and the operating instructions, and
in the data conversion process.
HIOKI cannot accept any responsibility for the results of using this disc.

The following symbols are used in this Instruction Manual to indicate the
relative importance of cautions and warnings.
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1.1 Product Overview
______________________________________________________________________________________________

Chapter 1
Overview

1.1 Product Overview

The 9334 LOGGER COMMUNICATOR comes with the following functions.

1. Real-time data acquisition
By connecting the MEMORY HiLOGGERs to a LAN, a single
measurement can be used to acquire data from up to 16 MEMORY
HiLOGGERs.
When you are acquiring data, in addition to waveforms, you can also
confirm values and alarms in real-time.

2. Various search functions
In addition to event markers, you can search for a variety of items,
including dates and maximum values.

3. Waveform display
Using a MEMORY HiLOGGER, you can display waveform files saved to
a PC card on the screen. Binary data can also be saved in CSV format.
This is convenient because it allows data to be used with spreadsheets
and other software.

4. Logger monitoring function
By connecting MEMORY HiLOGGERs to a LAN, you can monitor or
control those MEMORY HiLOGGERs on a single PC.
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1.2 Specifications
______________________________________________________________________________________________

Supplied media One CD-R

Supported recorders HIOKI 8420-01, 8420-51, 8421-01, 8421-51,

8422-01, 8422-51

Operating environment IBM PC/AT compatible computer Windows
XP/ Vista/ 7/ 8
(with LAN installed and TCP/IP available)

Communication Ethernet, TCP/IP

1.2 Specifications

General specifications

Functional specifications
Supports connection of up to 16 MEMORY HiLOGGERs
Displays waveforms, values, and alarms during real-time transfers
Waveform file display (supports MEM format binary files)
Scroll function
Zoom display
Allows you to zoom in and out on the voltage and time axes.
Display channel settings
You can display up to 512 analog channels, up to 256 logic channels, and
up to 64 pulse input channels.
Cursor function
Allows you to display the time difference and potential difference between
cursors A and B, as well as the time and electrical potential at each
cursor's position.
Parameter calculation function (can select section or cursor interval)
Allows you to calculate the average, peak, maximum, and minimum
measurements, as well as the maximum time, minimum time, ON time,
OFF time, number of times turned ON, number of times turned OFF,
standard deviation, integration, and area values.
Various search functions
Possible searches: Event marker, time, maximum measurement, minimum
measurement, peaks, valleys, alarm, level, window, and volume of change.
Marking function
Allows you to insert event markers while making measurements.
Conversion to CSV format (with cropping and interval specification)
Print function
Allows you to print waveform images.
Input comments
Allows you to insert comments in the desired positions.
Logger monitoring function
You can monitor or control those MEMORY HiLOGGERs.
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2.1 System Requirements
______________________________________________________________________________________________

NOTE
During data acquisition, transferring large quantities of waveform data from the
MEMORY HiLOGGER requires a corresponding amount of hard disk space.
Available hard disk capacity provided should be sufficient for the expected volume
of data.

Chapter 2
Setup

2.1 System Requirements

Using the 9334 requires the following minimum hardware and software
configuration.

Computer
IBM PC/AT compatible
Pentium 133 MHz (Pentium 200 MHz or more recommended)
64 MB RAM (256 MB RAM recommended)
5 MB of free hard disk space

Operating system
Microsoft Windows XP, Windows Vista, Windows 7 or Windows 8
Internet Explorer 4.01 or later

LAN
Physical LAN installation
Communication using TCP/IP

CD-ROM drive
Used for installation.

Display
Display function capable of 1024 x 768 or higher resolution
Uses a small font. (If you use a large font, it may alter the display.)
To change display settings, open Control Panel by pointing to Settings on
the Start menu. Then, double-click Display and click the Settings tab in
the Display dialog box.
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2.2 Installing and Removing the Software
______________________________________________________________________________________________

NOTE
When installing the software, if other programs are running it may not be possible
to complete the installation properly. Close all other programs before beginning the
installation. In particular, if any anti-virus program is running, it may prevent the
installation even though this software is not a virus. In this case, make the
appropriate settings in the anti-virus program to allow the installation to proceed.

2.2 Installing and Removing the Software

Installation
Use the following procedure to install the software.
1. Close all running applications.
2. Insert the supplied CD-R disc into the CD-ROM drive.
3. Run the setup file on the CD-R.

Click Run on the Start menu, then type R:\9334ENGLISH\setup.exe and
click OK. (Substitute the appropriate letter for R if your CD-ROM drive
uses a different name.)

4. The 9334 installer starts: follow the directions on the screen to complete
the installation.

5. If Internet Explorer 4.01 or later is not installed, install it. For the latest
version of Internet Explorer, see the Microsoft Web site, or a computer
magazine.

Removal
Use the following procedure to remove the software.
1. On the Windows Start menu, point to Settings and click Control Panel.

Double-click the Add/Remove Programs icon, to display the Add/Remove
Programs Properties dialog box.

2. On the Install/Uninstall tab of the dialog box, click 9334 LOGGER
COMMUNICATOR in the list of applications, then click Add/Remove.

This runs the uninstaller, which removes the 9334 software. All the
transferred data files remain, but can be removed manually when they are no
longer required.



5
_____________________________________________________________________________________________

2.3 Upgrading the MEMORY HiLOGGER Software
______________________________________________________________________________________________

NOTE
During the upgrade operation, do not turn off the MEMORY HiLOGGER's power.
If the power is turned off during the upgrade operation, the instrument must be
returned for repair.

2.3 Upgrading the MEMORY HiLOGGER Software

To use the 9334 LOGGER COMMUNICATOR, the software in the
MEMORY HiLOGGER must be 9334 compatible. First check the
MEMORY HiLOGGER software version number; you can find it on the
System screen of the MEMORY HiLOGGER.
9334-compatible versions are Ver 1.01 or later (8420-01, 8421-01), Ver 1.00
or later (8422-01), or Ver 3.00 or later (8420-51, 8421-51, 8422-51). When
the MEMORY HiLOGGER software is not compatible with a 9334, upgrade
it.

1. Prepare a PC card (Flash ATA card) that has been certified for use with
MEMORY HiLOGGERs. For PC cards whose use is certified for these
devices, refer to the MEMORY HiLOGGER Operating Instructions.
Further, make sure that the PC card is compatible with the computer you
are using. At least 2 MB of free space is required when using a PC card.

2. Insert the supplied CD-R disc into the CD-ROM drive.
3. Copy the upgrade file from the CD-R to the PC card. The upgrade files

are located in each model's folder. The upgrade file for the 8420-01 and
8421-01 is "8420V110.PRG" (located in the 8420V110 folder). The
upgrade file for the 8422-01 is "8422V105.PRG" (located in the
8422V105 folder). The upgrade file for the 8420-51, 8421-51, and 8422-
51 is "8420V307.PRG" (located in the 8420-50V307 folder).
If a 9334-compatible version of the MEMORY HiLOGGER software is
already present, no upgrade is required. However, be careful not to install
an older version inadvertently.

4. Prepare the MEMORY HiLOGGER for the upgrade. Ensure that a stable
power supply for the upgrade operation is used, if possible using an
uninterruptible power supply. This is important, because if the power fails
during the upgrade operation, the instrument must be returned for repair.

5. Carry out the upgrade.
Insert the PC card into the MEMORY HiLOGGER and press the Card key
to display the File screen. The upgrade files on the PC card are shown in
the File screen. Select an upgrade file, then read the file. The MEMORY
HiLOGGER starts the upgrade. This process takes about 2 minutes:
During this interval, simply wait for the process to finish. When the
upgrade is completed, the MEMORY HiLOGGER automatically restarts.
The upgrade is then complete.
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2.4 LAN Settings
______________________________________________________________________________________________

CAUTION Before connecting to the LAN for the first time, it is important to complete the
Interface settings. If the instrument is connected to the LAN without making
these settings, IP address conflicts with other devices on the network or
other problems may occur.

Host Name (up to 12 characters)  : __________________

IP Address           : ____.____.____.____

Subnet Mask          : ____.____.____.____

Default Gateway (present or not present, when present)
               : ____.____.____.____
TCP/IP Port Number       : ____X
You can set the upper three decimal digits of the port address
(the rightmost digit is set internally by this device).

2.4 LAN Settings

Preparations for the settings
First, when connecting to an existing network, it is necessary to obtain the
settings from the network administrator. You will need to obtain the
following from your network administrator.

Host name
This is the name of the MEMORY HiLOGGER on the network. It must
be distinct from the host names of all other devices on the network.
IP address
This is the identifying address of the MEMORY HiLOGGER. It must be
distinct from the addresses of all other devices on the network.
Subnet mask
This specifies the class (size) of the network.
Default gateway
If communications between the MEMORY HiLOGGER and the computer
pass through a gateway, specify it.
TCP/IP port number
This is the port used for TCP/IP communications between the MEMORY
HiLOGGER and the computer. Normally, the default 880x ports can be
used, but if these ports are already used by a different program on the
computer, specify different ports.

When the port number is specified as "880x" the ports used are as follows:
Port 8800: for the logger communicator
Port 8801: reserved
Port 8802: for control by communication commands
Ports 8803 to 8809: reserved

Use unavailable ports on the computer running the 9334 software.
Note that the ports are mapped to IP addresses, and do not have any relation
to the ports used by other devices on the LAN.
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2.4 LAN Settings
______________________________________________________________________________________________

Of course, if you are assembling a stand-alone network with no connections
to an existing network, you can still obtain the address information from the
administrator, or assign the setup values yourself if there is no administrator.
An IP address within the following range is recommended when setting up a
stand-alone network: 192.168.0.0 to 192.168.255.255.
However, the last number on the right may not be 0 or 255, so we
recommend setting the controller device (such as the PC) to 192.168.0.1, and
setting this instrument to 192.168.0.2.
If several MEMORY HiLOGGERs are connected, the last number should be
incremented by one for each instrument (for example, the next instrument
would be 192.168.0.3). The Host Name should be carefully selected to be
unique among the Host Names assigned to all the other devices.
Otherwise, the following settings should be satisfactory:
Subnet Mask   : 255.255.255.0
Default Gateway  : OFF
Port Number   : 880X

MEMORY HiLOGGER Settings
Carry out the MEMORY HiLOGGER settings in the Settings screen. For
more on how to display the Settings screen, refer to the MEMORY
HiLOGGER Operating Instructions.
Do not change the settings during a communications session.

Make sure that you enter the host name.
The delimiter and header settings are used for control by communications
commands.

Computer Settings
Using this software requires that the computer have a LAN connection
installed. For details on the LAN settings, consult Windows Help, or the
documentation supplied with your computer's LAN card. The computer must
also have TCP/IP.
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2.4 LAN Settings
______________________________________________________________________________________________
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3.1 Starting and Closing the Logger Communicator
______________________________________________________________________________________________

Menu bar
Toolbar

Status Bar

Chapter 3
Startup

3.1 Starting and Closing the Logger Communicator

To start the Logger Communicator, first click the Start menu button, then
point successively to [Programs], [HIOKI], [9334 Logger Communicator], and
finally click [Logger Communicator].
To close the logger communicator, on the [File] menu click [Exit].
You can also click the Close button on the upper right corner of the window,
or click the toolbar button shown on the left.
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3.1 Starting and Closing the Logger Communicator
______________________________________________________________________________________________
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4.1 Preparing for Real-time Data Acquisition
______________________________________________________________________________________________

Chapter 4
Real-time Data Acquisition

4.1 Preparing for Real-time Data Acquisition

Complete the following settings before starting real-time data acquisition:
1. Measurement systems
2. IP addresses of MEMORY HiLOGGERs used for data acquisition

These settings are made in the "Measurement Settings" dialog box. On the
menu, click [Measurement], then click [Settings] to display the
"Measurement Settings" dialog box.

The icons for Measurement 1 to Measurement 8 appear in the left box of the
"Measurement Settings" dialog box. These icons represent the eight
measurement systems. Up to 16 MEMORY HiLOGGERs are configured in
those systems. Data acquired from the loggers allocated to each system are
stored in the file set for the system. The measurement systems are
independent and data is acquired independently in real-time.
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4.1 Preparing for Real-time Data Acquisition
______________________________________________________________________________________________

4.1.1 Measurement System Settings
Click one of the measurement system icons (Measurement 1 to Measurement
8) in the tree view of the "Measurement Settings" dialog box. The "Settings"
page of the clicked measurement system will appear on the right. This page
allows various settings; such as selecting the file for saving acquired data,
the recording interval, and recording period. These settings apply to all
MEMORY HiLOGGERs allocated to the measurement system.

Setting Location and Filename
To set the location and the file for saving acquired data, type in the path and
filename, or use the <Browse> button. Click the <Browse> button to display
the "Browse" dialog box and choose the folder there.

Setting Recording Interval
Select a recording interval from the following presets:
100 ms, 200 ms, 500 ms, 1 s, 2 s, 5 s, 10 s, 20 s, 30 s, 1 min., 2 min., 5
min., 10 min., 20 min., 30 min., and 1 hr.

Setting Split Screen
Select the number of split screens from the following presets:
1, 2, 4, 8, and 16

Setting Recording Period
There are two methods of setting the recording period: selecting the number
of files that segmentize the Total Time, and selecting the number of files
with recording time per file.
1. No. files & total Time

Set the total recording time and number of files for recording data within
the time. For example, if the total recording time is set to one day and the
number of files is set to 24, data is recorded in each file for one hour.

2. No. files & time per file
Set the recording time for one file and number of files. For example, if the
recording time for one file is set to 1 hour and the number of files is set
to 24, data is recorded in each file for one hour.
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4.1 Preparing for Real-time Data Acquisition
______________________________________________________________________________________________

NOTE
The maximum size of a file is 200MB. When acquiring more than 200MB of data,
be sure to split the data into several files. No measurement data will be lost when
switching between files.

When multiple files are set using either method above, the files are named
using the set filename with serial numbers added.
Ex) Filename.HLW, Filename1.HLW, Filename2. HLW ... (HLW is the
extension.)

Setting Title
You can name the measurement systems.

Setting Time Axis Title
You can set a title that is displayed on the time axis of a waveform graphic.

Setting Automatic Update
Click <Refresh> button to display "Auto Refresh Setting" dialog box. Check
"Auto Refresh during real-time suspension" and set the updating interval. The
waveform display will be updated when the set time elapses during real-time
suspension.
Check "Auto change waveform sheet while measuring" and set the changing
interval. The waveform sheet will be changed when the set time elapses
during real-time measuring.

Setting Waveform Display Sheet Name
Click the <Sheet> button to display the "Sheet Name" dialog box. You can
name up to 16 waveform sheets (S1 to S16).

Time synchronization
Click the <Sync Clock> button to display the setting dialog box.

Put a check mark to select a logger to synchronize. Then, click the <Sync>
button to synchronize the time of the logger with the time of the PC.
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4.1 Preparing for Real-time Data Acquisition
______________________________________________________________________________________________

4.1.2 Setting IP Address of MEMORY HiLOGGER Used for Data
Acquisition

Click a measurement system icon in the left box of the "Measurement
Settings" dialog box to display the "Settings" page of the measurement
system. Click the <Register> button to display the "IP Address Settings"
dialog box.

Type in the IP address of the MEMORY HiLOGGER to be used for data
acquisition, then click the <Register> button. The MEMORY HiLOGGER is
then registered for the measurement system and the logger icon appears
under the measurement system icon.

For details on the settings of MEMORY HiLOGGERs, see 4.1.3, "Settings of
MEMORY HiLOGGERs," and 4.1.4, "Settings of Measurement Channels
and Modules."
To delete a registered MEMORY HiLOGGER, select its icon and press the

Delete key.
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4.1 Preparing for Real-time Data Acquisition
______________________________________________________________________________________________

4.1.3 Settings of MEMORY HiLOGGERs
Click the icon of a MEMORY HiLOGGER registered for a measurement
system. The "Settings" page for the MEMORY HiLOGGER will then
appear. On this page, you can send or receive setting data with the
MEMORY HiLOGGER, and edit the general MEMORY HiLOGGER
settings.

Setting IP address and Port number
To change the IP address or port number of a MEMORY HiLOGGER, click
the <...> button. The "Change" dialog box will then appear. Type in a new
address or port number.
For the port number, use the number set on the MEMORY HiLOGGER with
the low-order digit changed to 0. For instance, when "880X" is set on the
MEMORY HiLOGGER, change the "X" to "0" and use "8800" instead.

Obtaining Logger Information
After registering a MEMORY HiLOGGER for a measurement system, you
must obtain such logger information as the Model number and connected
device. Click the <Get Info> button to communicate with the MEMORY
HiLOGGER. The Model number and connected device will then be
displayed. In case of no response, check for proper LAN cable connection
and whether the IP address and port number are correct.



16
_____________________________________________________________________________________________

4.1 Preparing for Real-time Data Acquisition
______________________________________________________________________________________________

Setting Timeout
When Logger Communicator is communicating with a MEMORY
HiLOGGER and there is no response from the MEMORY HiLOGGER for a
certain time, a timeout occurs and the line is disconnected. If the LAN is
busy, however, data transfer may take longer than usual and a timeout may
occur even if there is no connection problem. If a timeout occurs often, set a
higher timeout limit. This setting doesn't apply during data acquisition.
Instead, the timeout is controlled based on an internally calculated recording
interval.

Sending Settings
Send the settings made on the 9334 to the MEMORY HiLOGGER.
Click the <Send Settings> button to display the "Send Settings" dialog box.

Check the settings you want to send, then click the <Send> button. The
settings will then be sent to the MEMORY HiLOGGER.

Receiving Settings
Obtain the settings from the MEMORY HiLOGGER to the 9334.
Click the <Receive Settings> button to display the "Receive Settings" dialog
box.

Check the settings you want to receive, then click <Receive> button. The
settings will then be sent from the MEMORY HiLOGGER.

Other
The setting items of the comment and measurement channel are the same as
those for the MEMORY HiLOGGER. For details, refer to the MEMORY
HiLOGGER instruction manual.
Data saved on a PC card by autosaving is saved in binary format only. Data
cannot be saved on a PC card in text format during real-time data
acquisition using the 9334.
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4.1 Preparing for Real-time Data Acquisition
______________________________________________________________________________________________

4.1.4 Settings of Measurement Channels and Modules
Double-click the icon of the MEMORY HiLOGGER registered for a
measurement system or click the plus (+) mark of the icon. The analog,
pulse, trigger, logic, alarm, and printer icons will then appear under the
logger icon. (Note that the logic, alarm and printer icons will not appear
unless the 8992 PRINTER UNIT and 8993 DIGITAL I/O UNIT are
connected to the MEMORY HiLOGGER.)

Double-click an icon (e.g., analog or pulse icon) or click the plus mark to
display the channel icons.

Click the channel, trigger, logic, alarm, or printer icon to display the related
"Settings" page. The setting items are similar to those for the MEMORY
HiLOGGER. For details, refer to the MEMORY HiLOGGER instruction
manual. The following settings, however, are not included or differ from
those for the MEMORY HiLOGGER.
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4.1 Preparing for Real-time Data Acquisition
______________________________________________________________________________________________

4.1.5 Saving a Setting File

Setting Display Sheet
On the "Settings" page for each analog or pulse channel or the logic
"Settings" page, you can set the display sheet used to display the waveform.
Click the <Sheet> button to display the "Select Sheet" dialog box. Check the
sheet you want to use to display the channel. You can display a waveform
on multiple sheets.
Setting ON/OFF Calculation Threshold
The "Settings" page for each analog channel allows you to set the threshold
for ON/OFF calculation. For details, see 5.4.4, "Displaying Cursor Interval
Calculation Results."
Setting Sound Alarm
The "Settings" page for the alarm allows you to set the sound alarm function
(i.e., playing back a WAV file at alarm output).
Check <Sound Alarm> and set the WAV file. To set the file, type in the path
of the file or use the <Browse> button. Click the <Browse> button to display
the "Open" dialog box, then choose a WAV file there.
To play back a WAV file, a soundboard must be installed on the PC.
Setting Trigger
The same trigger settings as the Memory HiLOGGER is possible, but some
settings are not applicable in the real-time data acquisition.
For details, see 4.2.1, "Starting Real-Time Data Acquisition".

You can save the settings made in the "Measurement Settings" dialog box as
a file. Click the <Save as...> button to display the "Save As" dialog box.
Choose a location at which to save the file, type in the filename, then click
the <Save> button.
The <Init> button initializes all settings made in the "Measurement Settings"
dialog box.
The <Open file...> button is used to open an existing setting file. Click the
button to display the "Open" dialog box. Choose a setting file in the dialog
box and open it.
The <Recent files> button displays a list of files you have recently worked
on. Click any file in the list to open it.
The <OK> button saves the settings made in the "Measurement Settings"
dialog box to the currently selected file, overwrites the file, selects the
setting file as the effective measurement settings, then closes the dialog box.
The <Cancel> button cancels the settings made in the "Measurement
Settings" dialog box and closes the box.

Real-time data acquisition is performed using the settings in the setting file
selected as the currently effective measurement settings. The status bar
displays the name of the setting file selected as the currently effective
measurement settings.
To set another setting file as the currently effective measurement settings,
open the file in the "Measurement Settings" dialog box, then click the
<Apply> button. You can also set the file by choosing [File] on the menu
bar, then clicking [Open Setting File]. The "Open" dialog box will then
appear. Choose and open the file you want to set as the currently effective
measurement settings.
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4.2 Starting/Aborting Real-Time Data Acquisition
______________________________________________________________________________________________

4.2.1 Starting Real-Time Data Acquisition

NOTE (In case of only one MEMORY HiLOGGER is registered in the measurement
system) When there is a stop trigger during the real-time data acquisition, the
measurement on the Memory HiLOGGER stops immediately but the 9334 stops
measurement after confirming no additional data is transferred from the Memory
HiLOGGER for a certain period. Therefore, there is a time lag to stop measurement.
Also, the waveform file of the 9334 has one additional data after the last data when
the measurement is stopped by a stop trigger.

4.2 Starting/Aborting Real-Time Data Acquisition

You can start real-time data acquisition upon completing the measurement
system settings and registering MEMORY HiLOGGERs allocated to the
measurement system.
Choose [Measurement] on the menu bar. Click <Start> to display a menu
showing [Start 1 - 8]. On this menu, click the number of the measurement
system you want to use to start data acquisition. Data acquisition will then
begin.
After starting data acquisition, the 9334 checks the settings of MEMORY
HiLOGGERs registered for the measurement system for matching with those
of the 9334. If the settings of any MEMORY HiLOGGER differ from those
of the 9334, the "Confirm" dialog box will appear. You can choose the
settings of the 9334 or those of MEMORY HiLOGGERs for data
acquisition. Choose either option and click the <Start> button.

When "Use 9334 settings" is selected, the 9334 sends its settings to the
MEMORY HiLOGGER before starting data acquisition.
When "Use logger settings" is selected, the 9334 receives the settings from
the MEMORY HiLOGGER before starting data acquisition. The setting file
is then overwritten with the settings received.
The <Cancel> button stops measurement.
In the real-time data acquisition, the trigger settings are effective when only
one MEMORY HiLOGGER is registered in the measurement system.
However, the trigger settings are automatically reset to "SINGLE" for trigger
mode and "0d 00h 00m 00s" for pre-trigger.
In case of multiple MEMORY HiLOGGER's are registered in the
measurement system, the trigger function cannot be used. All the trigger
settings of MEMORY HiLOGGER are reset when the real-time data
acquisition is started in this case.
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4.3 Screens During Real-Time Data Acquisition
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4.2.2 Aborting Real-Time Data Acquisition

4.3.1 Waveform Viewer

4.3 Screens During Real-Time Data Acquisition

Choose [Measurement] on the menu bar, then click [Abort] to display [Abort
1 - 8]. Click the number of the measurement system you want to use to stop
data acquisition. Data acquisition will then end.

After data acquisition has started, the waveform viewer begins to display
real-time waveforms received from MEMORY HiLOGGERs.
Clicking the button shown at the left during data acquisition will interrupt
the updating of waveforms (called real-time suspension). During real-time
suspension, you can scroll the screen to view the previous waveforms.
Clicking the button again during real-time suspension will cause the viewer
to start updating the waveforms again. Even when the updating of
waveforms is interrupted, the 9334 continues acquiring and saving data in a
file.

Click and drag the top of the status bar of the waveform viewer upward to
display the information screen. This screen shows the measurement start
time, end time, progress, files that have completed data recording, and the
measurement log.

The <Waveform>, <Calculate>, <Search>, <EventMark> and <Info> buttons
are located on the left side of the information screen. Clicking any of these
buttons will display the related setting page so that you can change the
settings. (Note that some settings cannot be changed during data
acquisition). For details, see Chapter 5, "Operating The Waveform Viewer."
You can choose to display or not display the information screen. Click
[Screen] on the menu bar, then click [Information Screen] to display the
Information Screen.
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4.3 Screens During Real-Time Data Acquisition
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4.3.2 Monitor Viewer

Displays the elapsed time. 1. 2. 3. 4.

On the Monitor viewer, the instantaneous value for each channel is digitally
displayed in real-time. However, the Monitor viewer can only be displayed
while data is being loaded.
To display the Monitor viewer, on the [Screen] menu, click [Monitor View].

You can also click the toolbar button displayed on the left.
A new screen is displayed each time you click the button.

To change the contents of the display, on the [View] menu, point to [Unit],
then click [Analog], [Pulse], or [Logic] and change the contents of the
display to Analog, Pulse, or Logic.

You can also click the toolbar buttons shown on the left. Starting from the
left: Analog Display, Pulse Display, and Logic Display are shown.

1. Displays the channel as a comment. If no comment is set, only the unit is
shown.

2. Displays the model and channel numbers. For example, channel 3 on the
first machine is displayed as "1-3".

3. Displays the current measurement value. The data is constantly updated at
the time interval that you set.
For Logic Display, High status is displayed as "1", and Low status as "0".

4. Displays the difference between the current measurement value and the
measurement value for the previous sample.
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Detailed Display Large Display

For Logic Display, you can choose from 2 formats: Detailed Display and
Large Display. On the [View] menu, point to [Logic], then click [Detail] or
[Large]. For Large, High status is displayed "red", and Low status "green".

You can also click the toolbar buttons shown on the left. From the left,
Detailed Display and Large Display are shown.

For Large Display, you can select from 2 channel display formats: Comment
Display and Channel Display. On the [View] menu, point to [CH Comment],
then click [Comment] or [CH].

You can also click the toolbar buttons shown on the left. Starting from the
left: Comment Display, and Channel Display are shown.

Changing the Display Update Interval
You can select from 3 display update intervals: 2 seconds, 10 seconds, and
Hold.
To select a display update interval, on the [View] menu, point to [Interval],
then click [2 Sec], [10 Sec], or [Hold].

You can also click the toolbar buttons shown on the left. Starting from the
left: 2 Seconds, 10 Seconds, and Hold are shown.

Changing Font
On the [View] menu, click [Font] to display the dialog box for fonts, then
change the font.

You can also click the toolbar button shown on the left.

Copying
On the [Edit] menu, click [Copy] to copy the display values (text format) to
the clipboard, then paste them into another program.

You can also click the toolbar button shown on the left.
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4.3 Screens During Real-Time Data Acquisition
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4.3.3 Alarm Viewer

Detailed Display Small Display

1. 5. 2. 3. 4.

The Alarm viewer displays the alarm output status in real-time. However, the
Alarm viewer can only be displayed while data is being loaded. (Valid only
when the 8993 DIGITAL I/O UNIT is connected.)
To display the Alarm viewer, on the [Screen] menu, click [Alarm View].

You can also click the toolbar button displayed on the left.
A new screen is displayed each time you press the button.

You can select from 3 display formats: Detailed Display, Large Display, and
Small Display.
On the [View] menu, point to [Logic View], then click [Details], [Large], or
[Small].

You can also click the toolbar button shown on the left.
From the left, Large Display, Small Display, and Detailed Display are
shown.

1. Displays the current alarm output status in color. When an alarm is output
it displays red, and when no alarm is output it displays green.

2. Displays the current alarm output status in numerical values. When an
alarm is output, "1" is displayed, and when no alarm is output, "0" is
displayed.

3. Displays the number of times an alarm was output from the start of
measurement until the present.

4. Displays the total time an alarm was output from the start of measurement
until the present.
When the alarm hold is set to On in the "Alarm Settings" screen, the
amount of time that elapsed since the alarm was first output until the
present is displayed.

5. Displays the amount of time that has elapsed since measurement started
until the present. Select a display format on the [View] menu by pointing
to [Time Notation], then clicking [Absolute], [Relative], [Sec], or
[Sampling No.] For details on display formats, refer to 5.2.2 "Changing the
Format of the Time Axis."
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Select an alarm for the MEMORY HiLOGGER that is displayed on the tab.
M1 is the first MEMORY HiLOGGER, and M2 is the second MEMORY
HiLOGGER.
If you select ALL, the alarms for all of the MEMORY HiLOGGERs that are
connected will be displayed.

Light mode settings
If light mode is set to On, you can easily confirm alarms visually, because
the entire background of the Alarm viewer lights red when an alarm is
output for any channel.
To activate the light mode function, on the [View] menu, click [Lighting].
You can also click the toolbar button shown on the left.

Changing Font
On the [View] menu, click [Font] to display the dialog box for fonts, then
change the font.
You can also click the toolbar button shown on the left.

Copying
On the [Edit] menu, click [Copy] to copy the display values (text format) to
the clipboard, then paste them into another program.
You can also click the toolbar button shown on the left.
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5.1 Opening a Waveform File
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5.1.1 Opening a Waveform File

5.1.2 Overwriting Waveforms

NOTE HLW files saved on the network computer cannot be overwritten.

Chapter 5
Operating The Waveform Viewer

5.1 Opening a Waveform File

On the 9334 LOGGER COMMUNICATOR, you can open real-time data
waveform files (with extension HLW) and MEMORY HiLOGGER waveform
files (with extension MEM).
Click [File] on the menu bar, then click [Open Waveform File] to display the
"Open" dialog box. Open the "Files of Type" drop-down list and choose a file
type. The files of the selected type will then be displayed. Choose the file
you want to open and click the <Open> button. The file will be read into the
9334 and the waveform displayed.

Each HLW file stores the conditions under which a waveform is displayed
on the waveform viewer. For a MEM file, a waveform setting file (with
extension HLC) is created with the same filename as that of the MEM file
and the display conditions are saved in this file. (The HLC file is
automatically read out when the MEM file is opened).
When the waveform viewer is displayed, click [File] on the menu bar, then
click [Save Waveform File]. The previous conditions are then overwritten by
the current waveform display conditions. The new display conditions will be
used when the file is next opened.
Click [File] on the menu bar, choose [Preferences], and then check
[Autosave Waveform Display Conditions]. The current waveform display
conditions will then be automatically saved and the previous conditions
overwritten each time the waveform viewer is closed.
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5.2 Making Changes to the Time Axis
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5.1.3 Applying Display Conditions to Measurement Settings

5.2.1 Changing the Size of the Time Axis

5.2.2 Changing the Format of the Time Axis

5.2 Making Changes to the Time Axis

Upon opening an HLW file, you can apply the display conditions for the
waveform viewer to the measurement settings of real-time data acquisition,
so that when real-time data acquisition is next performed, the waveforms are
viewed under current display conditions.
While the waveform of an HLW file is displayed, click [Measurement] on
the menu bar, then click [Apply Display Conditions]. The display conditions
will then be applied to settings for the measurement system to which the
same MEMORY HiLOGGER is registered. The same MEMORY
HiLOGGER means the logger used when the HLW file is created (when
performing real-time data acquisition).
The display conditions applied are only those that can be edited in the
"Measurement Settings" dialog box.

On the [View] menu, click [Zoom In] or [Zoom Out]. The time axis is
magnified or reduced.
You can also click either of the two toolbar buttons shown on the left.
Starting from the left: Reduce Display and Magnify Display are shown.
You can also right-click anywhere inside the Waveform Viewer and select
[Zoom In] or [Zoom Out].

You can change the format of the time axis. You can choose from the
following 5 format types:
1. Absolute Time: Displays the date and time.
2. Relative Time: Displays the time elapsed since measurement started and

the time.
3. Seconds: Displays the time elapsed since measurement started and the

time in seconds.
4. Sampling Number: Displays the sampling point.
5. Division: Displays the number of DIVs.

On the [View] menu, click [Time Notation], then click a display format.

You can also click any of the toolbar buttons shown on the left.

Starting from the left: the Absolute Time, Relative Time, Seconds, Sampling
Number and Division buttons are shown.
You can also right-click near the time axis scale and click [Time Notation]
from the shortcut menu.
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5.2.3 Changing the Type of Display

5.2.4 Changing the Character Color and Font

5.3.1 Changing the Magnification of the Voltage Axis

5.3.2 Changing the Gage Type

5.3 Making Changes to the Voltage Axis

You can change the way the time axis scale is displayed. You can choose
from the following 3 types of display:
1. Grid: Displays the scale in a grid format.
2. Upper and Lower: Displays the scale only on the left and right edges of

the time axis.
3. None: Does not display the scale.

To make settings, right-click near the scale on the time axis and click
[Type], then click [Grid], [Upper / Lower], or [None] from the shortcut menu.

You can change the color and font of the characters of the time axis scale.
To do this, right-click near the time axis scale, click [Text Color] or [Font],
and the Settings dialog box appears.

You can change the magnification of the voltage axis. To magnify the axis,
click [Voltage Axis Magnification] on the [View] menu.

You can also click the toolbar button shown on the left, then click anywhere
inside the waveform viewer. Each time you click, the magnification
increases one notch.
To gradually reduce the magnification, hold down the SHIFT key and click
anywhere inside the waveform viewer.

You can change the way the gage is displayed. You can choose from the
following 4 types:
1. None: Does not display the gage.
2. Upper and Lower: Displays one gage with the scale on the upper and

lower edges.
3. Detail: Displays one gage with its scale in a grid format.
4. Multi: Displays multiple gages.

You can also click any of the toolbar buttons shown on the left. Starting
from the left: None, Upper and Lower, Detail, and Multi are shown.

You can also right-click near the gage and point to [Type], then click
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5.3 Making Changes to the Voltage Axis
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You can also activate or
deactivate gages by
clicking here.

5.3.3 Changing Fonts, Vertical Fonts, and Character Color

[None], [Upper / Lower], [Detail], or [Multi].
If you want to change the number of gages displayed when the gage display
format is set to Multi, right-click near the gage and point to [Type], then
click [Gage Num] to display the "Gage Number" dialog box.
You can also make to activate and deactivate the gage for each channels in
the Information screen. To display the Information screen at the bottom of
the screen, click [Information Screen] on the [Screen] menu, .

You can also click the toolbar button shown on the left.

For example, when you click the <Waveform> button on the left of the
Information screen, you can activate or deactivate the gages of the
corresponding channels. To do this, right-click the channel for which you
want to activate or deactivate the gage and on the shortcut menu, click
[Gage] as illustrated below.

To make these changes, right-click near the gage, then click [Text Color],
[Font], or [Vertical Font] on the shortcut menu to display the Settings dialog
box.
1. Font: Horizontal area font
2. Vertical Font: Vertical area font
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5.4 Using Cursors
______________________________________________________________________________________________

5.4.1 Positioning Cursors

NOTE
During real-time measurement, you cannot position the cursors. However, you can
position them when the waveform display update is temporarily interrupted (refer to
4.2 "Starting a Real-time Data Acquisition Program").

5.4.2 Activating and Deactivating Cursors

5.4 Using Cursors

You can use cursors A and B to display cursor positions, dates, times, and
various types of cursor interval calculation results.

Click the toolbar buttons shown on the left, then move the mouse pointer in
the waveform viewer so it appears as a black arrow. Click the desired
position to set the cursor and an A mark or B mark appears at the top of the
waveform viewer.
If you click the button on the toolbar once more, the logger communicator
exits the setting mode.

To move the cursors, drag the A mark or B mark to a different location.

On the [View] menu, click [Cursor A] or [Cursor B] to activate or deactivate
the corresponding cursor.

You can also click the toolbar buttons shown on the left.
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5.4 Using Cursors
______________________________________________________________________________________________

5.4.3 Displaying Cursor Position Values and Times

1. 2.

Select the contents to be
displayed.

4.

3.

On the [Screen] menu, click [Cursor Screen] shown on the left to display the
Cursor screen on the right of the screen. Click the toolbar button shown the
Cursor screen.

Drag the edge of the Waveform Display screen or Cursor screen left or right
to change the size of the Cursor screen.
1. Click this to copy the display values to the clipboard (text format). You

can then paste them into another program.
2. Displays the position of the cursor on the time axis.
3. Displays the alarm output of the cursor position.

Green: No alarm.
Red: One or more of the alarms are assigned to the corresponding cursor.

4. Displays the measurement value at cursor A and B's respective positions.
Displays the channels of the selected sheet.
Alarms are split into sheets and displayed as follows: Sheet 1 is the first
MEMORY HiLOGGER, and Sheet 2 is the second MEMORY
HiLOGGER.



31
_____________________________________________________________________________________________

5.4 Using Cursors
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5.4.4 Displaying Cursor Interval Calculation Results

1. 2. 4. 5. 6. 7. 8. 9.3.

First, display the Information screen (refer to 5.3.2 "Changing the Gage
Type").
Next, click <Calculate> on the left of the Information screen to display the
calculation results.
You can also drag the edge of the Waveform Display screen or Information
screen up or down to change the size of the Information screen.

1. You can select from Analog, Pulse, Logic, or Alarm.
2. Displays the calculation range.

Display both A and B cursors on the Waveform Display screen: Calculates
the interval between cursors A and B.
Display only A cursor on the Waveform Display screen: Calculates the
interval between cursor A and the end measurement.
Display only B cursor on the Waveform Display screen: Calculates the
interval between the start measurement and cursor B.
Do not display the cursors on the Waveform Display screen: Calculates all
ranges.

3. After data is acquired, click to calculate.
4. Click to copy the calculation results to the clipboard (text format). You

can paste them into another program.
5. Click to calculate in real-time. Calculations are done automatically during

measurement. (The cursor interval cannot be calculated.)
6. You can select the time display format.
7. Adjust the filter settings to avoid calculation errors due to noise. The filter

range is 10 samples. The filter is only available when calculating the ON
Time, OFF Time, ON Count, and OFF Count. The filter is not available
when calculating logic or alarms. The filter should be turned OFF while
measuring.

8. You can select a channel whose threshold values for ON time, OFF time,
ON Count, and OFF Count are set.

9. Sets the threshold values for calculating ON Time, OFF Time, ON Count,
and OFF Count. These cannot be set while measuring. Make sure you set
them before measuring (refer to 4.1.1 "Measurement System Settings").
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Calculations
Average: The average value of the set calculation range.
P - P: The peak-to-peak value (maximum value to minimum

value) of the set calculation range.
Max: The maximum value of the set calculation range.
Max Time: The time until the maximum value of the set

calculation range.
Min: The minimum value of the set calculation range.
Min Time: The time until the minimum value of the set

calculation range.
ON Time: The total time during which the measurement value is

higher than the set threshold value of the set
calculation range. Cannot be calculated for pulse.

OFF Time: The total time during which the measurement value is
lower than the set threshold value of the set calculation
range. Cannot be calculated for pulse.

ON Count: The number of times that the measurement value rose
above the set threshold value of the set calculation
range. Cannot be calculated for pulse.

OFF Count: The number of times that the measurement value
dropped below the set threshold value of the set
calculation range. Cannot be calculated for pulse.

Standard Deviation: The standard deviation of the set calculation range.
Integral: The integral value of the set calculation range.
Area: The total surface area covered by waveforms and

origins of the set calculation range.
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5.5.1 Event Marker Search Function

1. 2. 4.3. 5.

NOTE
You cannot search for event markers while measuring in real-time. However, you
can search for them when the waveform display update is temporarily interrupted
(refer to 4.2.1 "Starting Real-Time Data Acquisition").

5.5 Search Functions

If event markers are inserted in the Waveform Display screen, you can
search for a specified event marker, then jump to that position to display the
waveform.
First, display the Information screen (refer to 5.3.2 "Changing the Gage
Type").
To display the Event Search screen, click Event Mark on the left of the
Information screen.

1. Click here to search for an event marker. Click the event marker that you
are searching for in the event marker list.

2. Click here to delete event markers. Click the event marker that you want
to delete in the event marker list.

3. You can select the kind of maker for the event marker.
4. Displays the position of the event marker that you selected in the event

marker list. If you change the numerical value here, the event marker
moves to that position.

5. Type a comment. Click an event marker in the event marker list, and then
type a comment. The comment is displayed in the comment column in the
event marker list.
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5.5.2 Other Search Functions

Search marker

1. 2.

3.

You can set up to 4 search criteria.

4.

In addition to jumping to event markers, you can display a waveform by
jumping to points that fulfill the waveform conditions that you specify.
A search marker is displayed in the search position.

To display the Settings screen for search criteria, click <Search> on the left
of the Information screen.

1. Click here to search for a point. To jump to a point that fulfills the search
criteria that you have set and display the relevant waveform, click here to
search the previous screen (the next screen to the left). Each time you
click here, the previous screen is searched.

2. Click here to search for a point. Each time you click here, the next screen
(the next screen to the right) is searched for points that fulfill the search
criteria that you have set, and if any points are found the screen jumps to
that point and displays the relevant waveform.

3. Selects a search mode. You can select from the following 9 search modes:
TIME AXIS: Jumps to the set date.
Max Pos: Jumps to the maximum measurement value of the channel

being searched.
Min Pos: Jumps to the minimum measurement value of the channel

being searched.
Peaks: Jumps to the peaks of the channel being searched.
Valleys: Jumps to the valleys of the channel being searched.
Alarm: Jumps to the set alarm output condition.

If you select All Alarms in Alarm Settings, display jumps to
the positions on all alarm channels where even one alarm
has been output.

Level: Jumps to the point at which the waveform rises above or
falls below the set level for the channel being searched.

Window: Jumps to a point within the set upper and lower limits (or
to a point outside the range) of the channel being searched.

Slope: Jumps to the point of increase for the inclination
(inclination per sampling interval) of the set waveform (or
the point of decrease) of the channel being searched.
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NOTE
You cannot use search functions while measuring in real-time. However, you can
search for them when the waveform display update is temporarily interrupted (refer
to 4.2.1 "Starting Real-Time Data Acquisition").

Copy the display value to the clipboard.

2.

Select the contents to be
displayed.

3.

1.

4. Sets items such as channels and search criteria. (The figure shows how to
search for the maximum measurement.)

If the Cursor screen is displayed, you can display the date of the search
point and the measurements for each channel.

1. Displays the point that was searched.
2. Displays the measurements of each channel of the point searched.
3. Displays the alarm output status of the point that was searched. This

displays green when no alarm is output, and displays red if an alarm is
being output on any of the channels.
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5.6.1 Changing the Origin and Magnification of Displayed
Waveforms

Click here to change the display color.

Switches waveform display On and Off.

5.6.2 Including Comments

1.

2.

5.6 Other Display Modifications

First, display the Information screen (refer to 5.3.2 "Changing the Gage
Type").
Next, click <Waveform> on the left of the Information screen and the display
position, magnification, and scaling settings screens appear. Click the
channel number that you want to modify, then set the origin, magnification,
and scaling.
After you have entered the various values, press the Enter key to apply the
settings.
To learn more about scaling, refer to the MEMORY HiLOGGER Operating
Instructions.

Screen range: Sets the upper and lower edge values on the Waveform screen.
If you scroll vertically using the vertical scroll bar on the
Waveform screen, the screen changes accordingly.
The screen range is -100 DIV to 100 DIV. You can also
change the upper and lower values as desired. (Changes are
reflected in the origin and magnification.)

1. You can type comments here. Double-click to switch to the edit comment
mode, then type your comment. If you want to change the character color
or font, right-click the comment, click [Text Color] or [Font], then change
the settings.
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NOTE
You cannot type comments while measuring in real-time. However, you can insert
them when the waveform display update is temporarily interrupted (refer to 4.2.1
"Starting Real-Time Data Acquisition").

5.6.3 Inserting Event Markers

5.6.4 Displaying Waveform Legends

Click to switch the display On and Off.

2. You can also type comments wherever you like on the Waveform Display
screen. To do so, click the toolbar button shown on the left, and, while
holding down the left mouse button on the position where you want to
insert the comment, set the insert comment range, then type the comment.
If you click the button on the toolbar once more, the logger communicator
exits this mode.

You can use the event marker function to attach event markers to acquired
data (either during or after acquisition) for later recall. (refer to 5.5, "Search
Functions")

Click the toolbar button shown on the left, then move the mouse pointer into
the Waveform Viewer so it appears as a black arrow. Click the desired
position to display the event marker "E" mark on the top edge of the
Waveform Viewer. If you click the button on the toolbar once more, the
logger communicator exits this mode.

On the [View] menu, click [Wave Remark] to display the waveform legend
on the right of the Waveform Display screen.
You can also right-click the voltage axis scroll bar.

If you want to change the size of the legend display frame, right-click
anywhere inside the display frame, click [Resize], then drag the display
frame with the mouse.
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5.6.5 Setting the Legend Channel Format

Comment Channel Settings

5.6.6 Turning the Channel Marker On and Off

You can choose a legend channel format from the following 3 types:
1. Comment: Displays the comments set for each channel.
2. Channel: Displays the channel number.
3. Settings: Displays the input type and the range.

On the [View] menu, point to [Channel Notation], click [Comment],
[Channel], or [Setting], then make the settings.

You can also click the toolbar buttons shown on the left.
Starting from the left: Comment, Channel, and Settings are shown.

You can also right-click anywhere inside the legend display frame, point to
[Channel Notation], then click [Comment], [Channel], or [Setting].
Similarly, to change the character color and font, right-click anywhere inside
the legend display frame, click [Text Color] or [Font], then make the
changes.

Right-click the channel marker, then click Analog, Pulse, or Logic to
activate or deactivate the display.
You can also click [Text Color] to change the character color of the channel
marker.
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5.6.7 Split-Screen Settings

Title bar

NOTE
During real-time measurement, the cursor cannot be set. If the screen is split during
real-time measurement, the cursor cannot be set for the waveform screen on the
right only.

5.6.8 Creating New Waveform Display Screens

On the [Screen] menu, click [Split Waveform Screen] to split the Waveform
Display screen vertically into 2. You can now edit the various screens.

You can also click on the toolbar button shown on the left or right-click
anywhere inside the Waveform Viewer, then click [Split] from the shortcut
menu.

To split the screen while data is being acquired in real-time, display the real-
time waveform currently being read on the left of the screen, then display
the most recent waveform on the right. Further, to change the waveform on
the right of the screen, right-click near a corner on the right screen, then
click [Refresh] to update to the most recent waveform.

You can also activate the right screen and click the toolbar button shown on
the left. To activate the screen, click anywhere on the right screen.

You can create a new Waveform Display screen that is identical to the
existing one. You can edit identical waveforms from various other screens.

You can also click the toolbar button displayed on the left.
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5.6 Other Display Modifications
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5.6.9 Settings of Waveform Display Sheet
You can display waveforms on up to 16 sheets (S1 to S16). Waveforms of
the same channel can be shown on multiple sheets. A single sheet can
display up to 64 analog channels, 32 pulse channels, or 32 logic channels.
Click [Screen] on the menu bar, then click [Sheet Settings] to display the
"Sheet Settings" dialog box.

Choose a sheet tab (S1 - S16), click the <Analog>, <Pulse>, or <Logic>
button, then check the channels you want to display on the sheet. When
using an HLW file, select a MEMORY HiLOGGER in the drop-down list
(M1 to M16) to set channels for each logger. Click <OK> to apply the
settings.
Click a sheet tab on the waveform display screen to display the waveforms
of the channels set for the sheet.

Right-click a tab to display the pop-up menu. Click [Edit Sheet Name] to
display the "Enter Sheet Name" dialog box so that you can set a name for the
sheet.
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5.6 Other Display Modifications
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5.6.10 Setting Split-Chart

5.6.11 Displaying Waveform Information

Select the contents to be displayed. Click to copy the display value to the clipboard.

Right-click on the waveform display screen to display the pop-up menu.
Click [Graph Num] and choose a number of splits from 1 to 16 Screens. The
waveform display screen will be split horizontally into the selected number
of charts.
The channels to display which charts are set on the "Display Settings" page
of the information screen.

You can confirm waveform information for files that are currently open or
being loaded, and a variety of information for analog, pulse, logic, and alarm
settings.
First, display the Information screen (refer to 5.3.2 "Changing the Gage
Type").
Next, click <Info> on the Information screen to display the waveform
information for the currently displayed sheet.
For alarms, treat the information for S1 as the first MEMORY HiLOGGER
and information for S2 as the second MEMORY HiLOGGER.
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5.6 Other Display Modifications
______________________________________________________________________________________________



43
_____________________________________________________________________________________________

6.1 Displaying the Logging Viewer
______________________________________________________________________________________________

Chapter 6
Operating The Logging Viewer

6.1 Displaying the Logging Viewer

When a waveform file has been read into the 9334 and the waveform viewer
is displayed, clicking [Screen] on the menu bar and choosing [Logging View]
displays the logging view of the waveform file.
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6.2 Numerical Value Display Screen
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Displays the alarm output status.
Red: Alarm output is active.
Green: No alarm.

6.2 Numerical Value Display Screen

To change the contents of the display, on the [View] menu, point to [Unit],
then click [Analog], [Pulse], [Logic], or [Alarm] and change the contents of
the display to Analog, Pulse, Logic, or Alarm.

You can also click either of the toolbar buttons shown on the left.
Starting from the left: Analog Display, Pulse Display, Logic Display, and
Alarm Display are shown.

For Logic Display, High status is displayed as "1", and Low status as "0".
For Alarm Display, "1" is displayed when an alarm is active, and "0" is
displayed when no alarm is active. Also for Alarm Display, Sheet 1 (S1) is
displayed as the first MEMORY HiLOGGER and Sheet 2 (S2) as the second
MEMORY HiLOGGER.

Changing the Channel Display
You can select from 2 types of channel display formats: Comment Display
and Channel Display. If a comment if not set for every channel, [CH] is
selected, even if you click [Comment].
When CH is selected, channel 3 on the first machine is displayed as "1-3".
On the [View] menu, point to [CH Comment], then click [Comment] or [CH].

You can also click the toolbar buttons shown on the left.
Starting from the left: Comment Display, and Channel Display are shown.
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6.2 Numerical Value Display Screen
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Changing the Display Interval
You can make cropping settings, then change the display interval for the
time elapsed.
On the [View] menu, point to [Thin Out], then click [1/1], [1/2], [1/5], [1/10],
[1/100], or [1/1000].

You can also click the toolbar buttons shown on the left.

Changing Waveform Formats for Time Elapsed
For details on display formats, refer to 5.2.2 "Changing the Format of the
Time Axis."
On the [View] menu, point to [Time Notation], then click [Absolute Time],
[Relative Time], [Sec], or [Sampling No.].

You can also click the toolbar buttons shown on the left. Starting from
the left: Absolute Time, Relative Time, Seconds, and Sampling Number
are shown.

Tracing Settings (during measurement)
When the tracing function is active, you can update the display so that the
time elapsed follows the values. If this function is inactive, the display is not
updated until the data is completely loaded, even if values are displayed all
the way to the bottom of the display screen.
To activate or deactivate the tracing function, on the [View] menu, click
[Trace].

You can also click the toolbar button shown on the left.

Copying
On the [Edit] menu, click [Copy] to copy the display values of the selected
lines (text format) to the clipboard, then paste them into another program.

You can also click the toolbar button shown on the left.

Click lines to select them.
To select more than one line, hold the Ctrl key while you click other lines
that you want to select.
You can select a block of lines by selecting the first line, then holding the

Shift key while you select the last line of the block.
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6.2 Numerical Value Display Screen
______________________________________________________________________________________________



47
_____________________________________________________________________________________________

7.3 Partial Conversion
______________________________________________________________________________________________

Chapter 7
Conversion To CSV File and

Merging Files

7.1 Conversion to CSV File

7.2 Full Conversion

7.3 Partial Conversion

You can convert waveform data to a CSV file. By converting data to CSV
format, you can read and utilize the data on spreadsheet applications. Data
can be fully or partially converted.

Click [File] on the menu bar, then click [Convert All] to display the "Convent
All" dialog box.
Type in the filename, set any necessary options, then click the <Save>
button.

Specify an area of data to be converted on the waveform viewer.

Set the save start position. Click the toolbar button as shown on the left.
Move the mouse pointer to the waveform display area. The pointer will
change into a black arrow. Click the position where you want to start
conversion. A light-blue "S" mark will then appear above the waveform
display area.

Set the save end position. Click the toolbar button as shown on the left. A
red "S" mark will then appear above the waveform display area.

The area between the two "S" marks above will be converted into a CSV
file. To change the area, drag the "S" marks.
Click [File] on the menu bar, then click [Convert Between Cursors] to
display the "Convert Between Cursors" dialog box. Type in the filename, set
any necessary options, then click the <Save> button.
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7.4 Conversion Options
______________________________________________________________________________________________

1.

2.

3. 4.

5.

6.

7.4 Conversion Options

1. Save as type
Select a file type from comma-separated, space-separated, and tab-separated
value format.
Choose from the "Files of Type" drop-down list.

2. Thinout
Select a number of sampling to set the conversion interval.

3. Format
Select a time axis format from Seconds, Date, Trig Time, and Point.
Choose from the "Time Axis Format" drop-down list.

4. Sheet
Select a sheet from the "Conversion Sheet" drop-down list. The data of
channels set for the selected sheet will be converted.
When [All Sheets] is selected, the data of all channels will be converted.

5. Conversion Channel
The channels set for the sheet selected from the "Conversion Sheet" drop-
down list are listed to the right of the dialog box. Tick Check the channels
you want to use to convert the data.

6. Open after convert
Check "Open after conversion" to start up the applications software
associated with CSV file (or Text file) after conversion and open the
converted file.
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7.5 Merging waveform files
______________________________________________________________________________________________

7.5 Merging waveform files

You can merge several split waveform files (waveform file of MEMORY
HiLOGGER) into one file.
From the [File] menu, select [Combine Waveform Files] to display the
"Combine Waveform Files" dialog box.

If you click the <Add File> button, the file dialog box opens so that you can
select files for merging. Added files appear in the list in order.
File merging is done according to the order of files in the list. If you want to
change the order of the files, select from the list the files you want to
change, and then click the <Up>/<Down> button.
If you click the <Combine> button, the file dialog box opens. Specify the
name of a file and whether you want to store the file.
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7.5 Merging waveform files
______________________________________________________________________________________________
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8.1 Detail Printing
______________________________________________________________________________________________

8.1.1 Print Reference

8.1.2 Detail Print Preview

NOTE
When using Windows 95/98/Me, note that the image may not be printed correctly
on A3 paper due to OS specifications. Therefore, increase the page margins to
reduce the print area when printing on A3 paper.

Chapter 8
Printing

8.1 Detail Printing

You can print out measurement data saved on a PC card from the
MEMORY HiLOGGER (as MEM format binary file) and measurement data
acquired by Logger Communicator (as HLW format binary file).

While the window of the waveform file you want to print is active, click
[File] on the menu bar, choose [Waveform Detail Print], then [Print] to
display the "Print" dialog box. Complete the settings of the printer and
printing area, then click the <OK> button. The printer will then start printing
using the current print reference settings.

While the window of the waveform file you want to preview the print image
is active, click [File] on the menu bar, choose [Waveform Detail Print], then
[Preview]. A preview of the print image will then be displayed according to
the current print preference settings.
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8.1 Detail Printing
______________________________________________________________________________________________

8.1.3 Detail Printing Settings

1.

2.

4.
5.

6.

7.
8.

9.

10.

11.
12.

13. 14. 15.

16.

17. 18. 19.

3.

Click [File] on the menu bar, choose [Waveform Detail Print], then [Page
Settings]. The "Waveform Detail Print Settings" dialog box will then appear
as shown below. The settings made in this dialog box will be applied to the
printing of all waveform files.

1. Print Format
Select a print format.
Set a number of partitions on the waveform chart by selecting one from [1
Graph] to [16 Graphs] in the "Format" box for printing channels allocated to
each chart. The allocation of each channel is determined according to the
split chart settings.
The selection of [2 Rows] to [16 Rows] determines the number of lines for
printing the chart. The print area on a page can be lengthened in the time
axis direction. Increasing the number of lines reduces the number of logic
waveforms that can be printed (and waveforms with smaller position
numbers are printed first).
"Portrait" and "Landscape" are printing directions.

2. Print range
Set the area to print.
[Display] prints the area currently displayed on the screen.
Selecting [All] prints entire Waveform.
[Selection] specifies an area from choices "Head", "Tail", "Cursor A", "Cursor
B." Note that a cursor not displayed (cursor A or B) cannot be selected.
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8.1 Detail Printing
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3. Time-axis Zoom
Selecting [Same as Screen] prints data using the same time axis
magnification as that of the chart shown on the screen. Any data exceeding
one page will be printed on multiple pages.
[Fit to One Page] automatically reduces the time axis magnification so that
the data is printed on one page only.
Selecting [Each 1DIV] for the "Page Break" setting causes the printer to end a
page at every division. Selecting [Each 5DIV] causes the printer to end a
page at every five divisions. These options cannot be selected when [Fit to
One Page] is selected.

4. Specify margins/Set 1DIV to 1cm
[Specify Margin] allows you to specify the left, right, top, and bottom
margins in units of 1 mm. The chart size will be reduced according to the
margins set.
[Set 1DIV to 1cm] prints the data with a grid set to 1 cm. With some printers,
all data may not be printed.
Printing with a grid of 1 cm is only available for printing on A4 and A3
paper. When printing on other size of paper, choose [Specify Margin].

5. Margins
Set the left, right, top, and bottom margins in increments of 1 mm.

6. Sheet
Set the sheet to print. Choose [All] or [Only Displayed].

7. Grid type
Select a type of grid from [OFF], [Standard], [Detail], and [Time-axis].

8. Gage
Select a type of gage from [Upper / Lower] and [Detail]. [Upper / Lower]
prints the upper and lower limit values of each channel only. [Detail] prints
the upper and lower limit values and the values on all scale graduations. One
gage is printed for every channel. Therefore, print areas for waveforms will
be reduced when there are many channels.
[Max] sets the maximum number of detail gages to print per chart. If there
are more channels than the maximum number set, the gages will be printed
for channels with higher display priority. Note that some printing formats
may provide fewer gages than specified in this setting.

9. Channel Marker
Set a print method for the channel markers of analog and logic waveforms.
Choose [OFF], [CH Number.], or [Comment]. Selecting [Comment] without
setting a comment for a channel will only print the CH No. for that channel.

10. Header
Specify the information you want to include in the header. Select
"Measurement Info.", "Info.+Title Comment", or "Info.+File Name."

11. CH Info.
Set whether to print channel information (e.g., range and display
magnification). Choose [OFF] or [ON].
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8.1 Detail Printing
______________________________________________________________________________________________

12. Marker Value
Specify whether you want to print measurement value at cursor A and B,
event marker respective positions. Select "OFF", "Cursor", "Event Marker" or
"Both".

13. Printer...
The "Printer Settings" dialog box will appear.

14. Preview
The print preview will be displayed according to the current detail print
settings.

15. Print...
The "Print" dialog box will appear to initiate printing.

16. Advanced...
The "Advanced Settings" dialog box will appear. This box allows you to
select a line for the chart, a character font, or to edit various other settings.

17. Default
Initialize the detailed print setting.

18. OK
End the setting.

19. Cancel
Close the dialog box without applying the changes. Clicking the <Preview>
button applies the changes made thus far. Clicking the <Cancel> button after
performing Preview does not retain the settings made before the Preview.
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8.1 Detail Printing
______________________________________________________________________________________________

8.1.4 Advanced Settings

1.

2.

7.

3. 4.

5. 6.

8. 9.

Click the <Advanced...> button in the "Waveform Detail Print Settings" dialog
box to display the "Advanced Settings" dialog box. This box allows you to
select a line for the chart, a character font, or to edit various other settings
as shown below.

1. Print Color
Select from [Color], [Gray scale], or [Black and white].

2. Item
Select a portion of the chart to which to apply the new settings. The
following settings are applied to the portion selected here.

3. Line Width
Select a width of the line used for the waveform and grid.

4. Line Type
Select the type of line used for printing the grid, vertical line, and horizontal
line (Solid line/Dot line).

5. Font
Click the <Select...> button to open the "Font" dialog box. Select a character
font.

6. Color
Click the <Color> button to open the "Color" dialog box. Select a color.

7. Set line width and color of each CH.
This setting is available when [Analog waveform], [Pulse waveform], or
[Logic waveform] is selected for the "Item" setting.
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8.2 Screen Printing
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8.2.1 Screen Printing

8.2.2 Screen Print Preview

8.2 Screen Printing

Selecting this option allows you to configure the setting of each channel.
Note that the line width and color shown on the screen will be used when
this option is not selected.

8. OK
End the setting.

9. Cancel
Close the "Advanced Settings" dialog box without applying the changes.

While the window of the waveform file you want to print is active, click
[File] on the menu bar and choose [Screen Print], then [Print]. The "Print"
dialog box will then appear. Complete the printer settings and click the
<OK> button. The printer will start printing using the current screen print
settings.

While the window of the waveform file you want to preview is active, click
[File] on the menu bar, choose [Screen Print], then [Preview]. A preview will
be displayed according to the current screen print settings.
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8.3 Logging Printing
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8.2.3 Screen Printing Settings

1. 2.

8.3.1 Logging Printing

8.3.2 Logging View Print Preview

8.3 Logging Printing

Click [File] on the menu bar, choose [Screen Print], then [Page Settings].
The "Screen Print Settings" dialog box will then appear. The settings made
in this dialog box will be applied to the screen printing of all waveform files.

1. Output Color
Choose an output color option from [Color], [Gray Scale], and [Black and
White].

2. Position
When [Print in the center of paper] is checked, the image is printed in the
center of paper.

While the logging window of the waveform file you want to print is active,
click [File] on the menu bar and choose [Logging Print]. The "Print" dialog
box will then appear. Complete the printer settings and click the <OK>
button. The printer will start printing using the current logging print settings.

While the logging window of the waveform file you want to preview is
active, click [File] on the menu bar, then choose [Logging Print Preview]. A
preview will be displayed according to current logging print settings.
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8.3 Logging Printing
______________________________________________________________________________________________

8.3.3 Logging Print Settings

1.
2.

3.

4. 5. 6.

7. 8.

Click [File] on the menu bar, then choose [Page Settings].to display the
"Logging Print Settings" dialog box. The settings made in this dialog box
will be applied to the logging printing of all waveform files. Parameters on
the "Logging Print Settings" dialog box are following.

1. Orientation
Set the page orientation. Choose [Portrait] or [Landscape].

2. Font
Click the <Font> button to open the "Font" dialog box. Select a printing
font.

3. Margins
Set the left, right, top, and bottom margins in units of 1 mm.

4. Printer
Display the "Set Printer" dialog box.

5. Preview
A print preview is displayed according to the current logging print settings.

6. Print
Displays the print dialog box to let you begin printing.

7. OK
Click OK to finish entering settings.

8. Cancel
The dialog box is closed, without saving the changes you entered just now.
(If you used Preview to preview the print image, changes made by that point
are applied. Selecting Cancel after preview will not restore the original
settings in place before the preview.)
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Chapter 9
Logger Monitoring

9.1 Startup

You can monitor and control multiple MEMORY HiLOGGERs on a single
PC via a LAN. You can also send waveform data stored in logger memory
to the PC.

Click the <Start> button on Windows. Choose [Programs] - [HIOKI] - [9334
Logger Communicator] - [Logger Monitoring] to start up the logger-
monitoring program (Logger Watcher).
To quit the program, click the <Exit> button or click the close button in the
top-right corner of the window.



60
_____________________________________________________________________________________________

9.2 Monitoring Settings
______________________________________________________________________________________________

9.2.1 New Logger Registration

9.2 Monitoring Settings

Before starting logger monitoring, register a logger to monitor on the logger-
monitoring program and complete necessary settings (including IP address).

Click the <Register> button to display the "Register" dialog box. Complete
the settings of the logger to monitor as shown below.

Connection
IP Address
Type in the IP address of the logger to monitor.
Port
Set the port number used for communications with the logger. If the port
number setting has not been edited on the logger, leave the "8800" default
setting. For details, see 2.4, "LAN Settings."
Timeout
Set the timeout limit to use during communications with the logger. If the
logger doesn't respond within the seconds set here, the line will be
disconnected.
Start watching at starting up
Selecting this option will automatically begin monitoring when the logger-
monitoring program starts up.

Waveform receiving settings
Set at every reception/Set in advance
When [Set at every reception] is selected, you will be prompted for "Save
Folder" location and "Filename" every time you receive waveform data.
When [Set in advance] is selected, waveform data will be received according
to the "Save Folder" and "Filename" settings made beforehand.
Save Folder
This setting is available when selecting [Set in advance]. Type in the name
of the folder to save received waveform files. Clicking the ">>" button
displays the "Browse" dialog box so that you can select a folder there.
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9.3 General Settings
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9.2.2 Changing Monitoring Settings

9.2.3 Deleting a Registered Logger

9.3 General Settings

File Name
This setting is available when selecting [Set in advance]. Type in the
filename for received waveform files. The files are saved using the set
filename with added serial numbers.
OK/Cancel
Click the <OK> button to register the logger for the logger-monitoring
program and display it in the list.
Click the <Cancel> button to cancel the settings.

You can change the monitoring settings of loggers registered for the logger-
monitoring program. Select a logger you want to change the monitoring
settings from the list. Click the <Properties> button to display the
"Properties" dialog box. The settings in this dialog box are the same as those
in the "Register" dialog box.

Select a logger you want to delete from the list, then press the Delete key.

Click the <Option> button to display the "Option" dialog box. This dialog
box allows you to edit the general settings of the logger-monitoring program
as shown below.

Listen Port
Set a port number used to receive events from the loggers. If the port
number setting has not been edited on the logger, leave this at the "9000"
default setting. For details, see 2.4, "LAN Settings."
Click the <Default> button to reset the port number to "9000."
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9.4 Control
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9.4.1 Starting/Ending Monitoring

9.4 Control

Sound alarm
You can set a sound alarm to play a set sound (WAV file) when receiving
an event from a logger. Select an event from the "Event" drop-down list,
check the box, then type in the path of the WAV file in the edit box.
Clicking the < Browse...> button displays the "Browse" dialog box so that
you can select the WAV file there.
If the box is not checked, a sound won't be played for the event. For types of
events, see 9.4.1, "Starting/Ending Monitoring."

Register to startup
Click the <Register to startup> button to add the logger-monitoring program
to the Windows startup menu.

OK/Cancel
Click the <OK> button to apply the settings.
Click the <Cancel> button to close the dialog box without applying the
settings.

When a logger is registered for monitoring, the logger can be controlled on a
PC. For example, you can start and end monitoring, start and interrupt
measurement, and receive waveform data in logger storage memory.

Select a logger from the list and click <Watch>. Monitoring of the logger
will begin and current logger status will be displayed under "Status" on the
list. The following types of status will be displayed:

Standing by
The logger is idle.
Waiting for trigger
The logger is waiting for a trigger.
Measuring
The logger is performing measurement. The measurement end time will be
displayed.
Measuring continuously
The logger is performing continuous measurement.
Saving text
The logger has completed measurement and it is now saving text data to a
PC card.

If the status changes during monitoring, the logger sends out an event and
the status on the list will be changed. The event will be recorded in the log.
An event log is created separately for each registered logger. To display the
log of a logger, select the logger from the list.
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9.4 Control
______________________________________________________________________________________________

9.4.2 Starting/Aborting Measurement

9.4.3 Receiving Waveform Data

Loggers will send the following events:
Measurement start
Sent when measurement is started.
Trigger notification
Sent when a trigger is activated.
Measurement end
Sent when the set recording time of measurement has been reached.
Text saving end
Sent when text data has been saved to a PC card.
Measurement abort
Sent when measurement is interrupted.
Real-time measurement start
Sent when real-time measurement is started via the 9334 LOGGER
COMMUNICATOR. When this event is received, the 9334 stops monitoring
the logger.
Alarm
Sent when an alarm occurs. (8420-01, 8421-01 Ver2.00 or later)
Notification mode start
Sent when monitoring by the logger-monitoring program is started by
operation on the logger.
Notification mode end
Sent when monitoring by the logger-monitoring program is ended by
operation on the logger.
Listener change
Sent when another logger-monitoring program starts monitoring. When this
event is received, the 9334 stops monitoring the logger.
Selecting the monitored logger on the list and clicking [End Monitor] ends
monitoring.

You can start or abort measurement of the logger being monitored.
Select the logger you want to control from the list, then click the <Storage>
or <Abort> button.

You can receive waveform data saved in the storage memory of the logger
being monitored.
Select the logger you want to receive the waveform data from the list, then
click the <Receive> button. The "Receive Waveform Data" dialog box will
then appear provided that [Set at every reception] is selected on "Properties"
for the logger. Type in the location where to save the data and the filename.
Then click the <Receive> button.
After the data has been received, the path of the file will appear on the log.
Move the mouse pointer to the line where the file path is displayed, and
double-click it to open the file on the 9334 LOGGER COMMUNICATOR.
You can also right-click the line to open a pop-up menu. Choose [Open] or
[Explorer] to open the file or to browse using Explorer.
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9.6 Other
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9.5 Starting/Ending Monitoring by Operating the Logger

9.6 Other

You can control the logger-monitoring program on a logger to start or end
logger monitoring. On page 2 of the logger communications settings, enter
the IP address of the PC, which runs the logger-monitoring program in "IP
Address" of [Monitor Server] and enter the number set as the "Listen Port"
No. (default 9000) of the monitoring program's general settings in "Port".
Then turn ON [Monitor Server] to start monitoring by the logger-monitoring
program.
Any logger not registered for the logger-monitoring program will be
automatically registered. Turn OFF [Monitor Server] to end monitoring.

When an event is received from a logger not selected from the list (i.e.,
when the log of the logger is not displayed), "Status" will be displayed in
red to report an event received from that logger. When you select the logger
in red and display its log, the logger's color will revert to the normal color.






